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Welcome to SmartChecker

Distribution Requirements and Evaluation Licence

Introduction
Installation
Using with Microsoft Excel.
Using with other spreadsheets.
If you don't have a sound card - using the MS Speaker Driver
Higher quality sound, and using your own sounds.

Purchasing a licensed copy
Upgrade Policy and Getting Support

This software is supplied as is without warranty or representation either express or implied 
with respect to the program or its documentation including their quality, performance, 
merchantability, or fitness for a particular purpose.

In no event will Oakley Data Services or any of its agents or assigns, or any organization 
distributing SmartChecker on its behalf be liable for direct, indirect, special, incidental, or 
consequential damages arising out of the use of, or inability to use the program.

All trademarks are acknowledged.



Limited Evaluation Licence
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This product is not public domain or free software. If you have not already purchased this product, 
you have the right to evaluate it for a period of 30 days from the date you initially install it. If you find 
that it suits your needs and you wish to continue to use it after the 30 day period you are required to 
purchase a fully licensed copy from Oakley Data Services or one of its agents. 

You also have the right, and in fact you are actively encouraged, to distribute copies of the evaluation
version of this product. The evaluation version is defined as a copy which does not include the 
SMTCHK1X.DLL file. You may assume you have our authority to distribute this product unless we 
explicitly tell you otherwise. It must, however remain in its original, unmodified state, and all its 
constituent files must be included. No-one may charge for the program itself, although a reasonable 
fee for the media used and copying costs is allowable.

You may not distribute copies of the licensed version of this product. You 
may not distribute the SMTCHK1X.DLL file in any form.
All rights not specifically granted here are reserved by Oakley Data Services.

This software is supplied as is without warranty or representation either express or implied with 
respect to the program or its documentation including their quality, performance, merchantability, or 
fitness for a particular purpose.

In no event will Oakley Data Services or any of its agents, or assigns, or any organization distributing
SmartChecker on its behalf be liable for direct, indirect, special, incidental, or consequential 
damages arising out of the use of, or inability to use the program.

All trademarks are acknowledged.



General
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Introduction
SmartChecker is a simple utility that provides the ability for spreadsheets to "read back" columns of 
figures to you, to save you having to either keep looking up and down to check you have entered 
things correctly, or getting a colleague across to read it out for you. It will work with any standard 
sound card capable of playing Wave files, or can use the Microsoft speaker driver (included in the 
ZIP) if you don't have a sound card.

How Does it Work
All SmartChecker does is read any digits on the clipboard and then terminate when there are no 
more digits. You can also Pause/Resume the read back by using the buttons or the space bar, or 
terminate the read back at any point. To make it work with your spreadsheet you will therefore need 
to create a macro that copies the selected range to the clipboard and then calls SmartChecker. Click 
on the appropriate item below for some samples:-

Using with Microsoft Excel.
Using with other spreadsheets



Using with Microsoft Excel.

Copyright © 1995 Oakley Data Services
Call +44 (0)1270 759739, Fax +44 (0)1270 765272, CIS 74774,1347

A macro suitable for use with Excel 5 is provided, both as a standard worksheet with the name of 
SMARTCHK.XLS, and converted to an Add-In with the name SMARTCHK.XLA.

How it works
The macro first reads the WIN.INI file looking for an entry in a section called "SmartChecker" with the
keyword "Location". It uses the information it finds to then execute the SmartChecker program, 
having first copied the selected cells to the clipboard. The SmartChecker program then reads the 
digits on the clipboard.

The WIN.INI file is modified when you first run SmartChecker, and subsequently if you ever move the
SmartChecker program.

For this reason you must have executed SmartChecker independently at least once before 
you try using it with the supplied Excel 5 Macro/Add-In. Also, if you move it just execute it 
independently again.

Testing
To try out SmartChecker with Excel 5 simply:-

1 Execute SmartChecker once independently of Microsoft Excel. The easiest way is probably to 
just double-click on it (SMARTCHK.EXE) from File Manager. It will be in the directory you 
installed it in. If there are any odd digits on the clipboard it will read them, but you can ignore 
that.

2 Open the SMARTCHK.XLS worksheet in Excel 5.
3 Select a range of cells with numbers in from Sheet1.
4 Select the Tools menu, and then select the "SmartChecker" option which will be at the bottom. 

The digits will be read back to you.

Installing as an add-in
You can install SmartChecker permanently as an Add-In that will always be available to all your 
worksheets by:-

1 Closing the "SMARTCHK.XLS" worksheet if you have it open.
2 Selecting the "Add-Ins" option of the "Tools" menu.
3 Use the "Browse" button on the dialog that appears to locate the "SMARTCHK.XLA" file we 

supply (this is the XLS file converted to an Add-In).
4 Select the "SMARTCHK.XLA" file once you have located it, and then press OK.
You will now have a "SmartChecker" option permanently installed on the Tools menu, ready for use 
at a moments notice..



Using with other spreadsheets.
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You can make SmartChecker work with almost any Spreadsheet package that has a macro 
language. There is only a macro for Excel 5 currently distributed, but we are working on macros for 
other spreadsheets. These macros will be made available free of charge on our Internet site at 
http://www.smartcode.com and in our support forum on CompuServe - section/library 4 of the 
UKSHARE forum. We will also supply whatever macros we have at the time you purchase the 
licensed version - call to see if we have done a version for your spreadsheet.

However, you can probably make it work quite easily yourself. The basic requirements for a macro 
are to:-

1 Read the "Location" key of the "SmartChecker" section of WIN.INI - this will give the complete 
location of the SmartChecker program provided it has been executed at least once.

2 Copy the selected range to the clipboard.
3 Execute the SmartChecker program, using information from step 1 to locate it.
Please note however that we cannot offer to help you write the macro - we aren't experts at 
spreadsheets!



Installation
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Installation
Just copy all the files to a directory somewhere, and then add a macro to your spreadsheet to invoke 
it (or to any other program you want to - it doesn't have to be a spreadsheet - if you have columns of 
figures in a Word-Processing document you can get it to read them too). 

With some packages you can also add buttons to your toolbars if you want to - you will need to check
the documentation for the package you intend to use it with.

Using with Microsoft Excel
Using with other Spreadsheets



If you haven't got a sound card
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Using the Speaker Driver
If you haven't got a sound card, don't worry, you don't need to miss out on the audible feedback that 
makes SmartChecker such a powerful tool.

It is possible to make SmartChecker "speak" through your normal PC Speaker, using the PC-
Speaker driver which we have included with SmartChecker.

To make use of the Speaker Driver, you first need to "install" it, and the steps required are as 
follows:-

1 Start the Windows Control Panel, usually found in the "Main" group in Program Manager.
2 Double-Click on the "drivers" Icon to start the driver installation utility.
3 Click on the "Add" button.
4 Select "Unlisted or Updated Driver" from the list (it is usually at the top), and click on "OK".
5 When asked to insert the disk with the new driver on, type in the directory in which you installed 

SmartChecker and click on OK. Alternatively you can click on the "Browse" button and navigate 
to the correct directory.

6 Follow the instructions for configuring the driver, using the "Test" option usually provides good 
quality sound.

Some notes about the Speaker Driver
There is an option in the Speaker Driver configuration to run it with "interrupts disabled" which 
effectively means while it is vocalizing a digit or phrase your PC will not respond to the keyboard or 
to mouse movements. We would suggest that you don't select that option, because you then won't 
be able to pause SmartChecker!

If you decide to replace the sounds provided with some of your own it is advisable to keep them fairly
short and crisp.



Higher quality sound
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General
SmartChecker uses twelve Wave files for the digits "zero" to "nine", the word "minus", and the "ding" 
that separates different groups of numbers. Depending on where you sourced the evaluation version 
of the program you may have sounds sampled at either 11kHz - 8bit or 22kHz - 8bit or 22kHz - 16bit. 
The 16 bit, 22kHz samples are the highest quality, but also require the largest files. It is probably best
to use these if you have a high-quality sound card. If using the Speaker Driver then the 22kHz, 8 bit 
files are perfectly adequate. The 11kHz,    8 bit samples are a little "tinny" but still perfectly useable on
any system.

SmartChecker will determine the highest quality set of Wave files available, and use those, unless 
you have provided a set of samples of your own (perhaps in your own language).

The naming convention is as follows:-

· SCU0.WAV -> SCU11.WAV are the names you should use if you provide your own sample files. 
We do not supply these files.

· SCH0.WAV -> SCH11.WAV are the highest quality sound samples. (22kHz, 16bit).
· SCM0.WAV -> SCM11.WAV are the medium quality sound samples. (22kHz, 8bit).
· SCL0.WAV -> SCL11.WAV are the lowest quality sound samples (11kHz, 8bit)
SmartChecker looks for the files in that order and uses the first set it comes across. The content of 
each file is:-

· SCx0.WAV -> SCx9.WAV are the digits 0 to 9.
· SCx10.WAV is the word "minus"
· SCx11.WAV is the "ding" between numbers.

Obtaining the others
All the sets of samples are supplied with the licensed version, or you can download them from our 
Internet site at http://www.smartcode.com or from our support forum on CompuServe, Section/Library
4 of the UKSHARE forum.



Ordering

Select the "Order Form" button on the reminder screen or from the main screen for phone numbers 
and addresses.

You can purchase your full copy of SmartChecker by Phone, Fax, Mail or E-Mail. If you have a 
CompuServe account you can also order via the SWREG service.

Printing an Order From
You can access an order form if you wish to register by Fax, Mail or E-Mail by pressing the 'Order 
Form' button on the reminder screen or the main screen. The order form shows the current 
registration fees and addresses and phone numbers.

Multiple Copy Licences
Ordering a single copy of SmartChecker allows you to use it on a single PC, and to make back-up 
copies for security purposes. It does not permit installation on more than 1 PC at the same time, or 
use on multiple work stations connected to a network.

However, we do offer extremely attractive discounts for multiple-copy licences, allowing you to make SmartChecker an integral
part of your network, site or corporation. Please contact us for details.



Upgrade Policy and Getting Support

Copyright © 1995 Oakley Data Services
Call +44 (0)1270 759739, Fax +44 (0)1270 765272, CIS 74774,1347

Upgrade Policy
The code (.EXE file) for the registered and unregistered versions of the program are identical, and it 
is the presence of a file SMTCHK1X.DLL that is supplied with the registered version that causes the 
program to behave in a registered fashion. The presence of the DLL will also cause any further 
versions of SmarChecker that still bear the 1.x release number to behave as registered versions, 
wherever you obtain them from. Versions that bear the 1.x release number will generally be for minor
enhancements and bug-fixes. Any release containing major new functionality will bear the release 
number 2.x, and an upgrade fee will probably be chargeable.

We will make new versions of SmartChecker available via the usual sources, on-line on services 
such as CompuServe, CIX and the Internet and via disk vendors, cover disks and CD's.

The prime locations for new releases are our support section on CompuServe, section 4 of the 
UKSHARE forum (the latest versions of all our products are available in Library 4), and at 
http://www.smartcode.com and ftp://ftp.smartcode.com on the Internet.

If you do acquire a newer version of SmartChecker simply ensure that the SMTCHK1X.DLL file you 
got when you registered is either in the directory that the SmartChecker program is in, or is in your 
WINDOWS directory.

Getting Support
For support, please contact the agent you purchased the program from (you can obtain contact 
information by selecting the "Order Form" item from the "Help" menu).

Alternatively you can ask in our support areas on various On-line Services:-

On CompuServe - GO UKSHARE section 4.

On the Internet - via the World Wide Web at http://www.smartcode.com

On CIX - join the "oakley" conference.

But before you reach for the phone, please make sure you have looked through this Help File 
first. If you have a question that this Help File doesn't answer, or are reporting what appears 
to be a bug then we will be pleased to hear from you. But if it is a question that is answered in
this Help file then all we will do is point you to the relevant section, and you will just get an 
answer a little bit slower. This is not meant to be awkward, but we try to keep our costs down 
to allow us to produce this high quality software at value-for-money prices, and answering 
support calls is an expensive undertaking. After all, some of the major software companies 
either charge for support or provide it on premium-price phone numbers. We don't want to 
have to do that.

This program is authored by:-



Oakley Data Services,
3, Oakley Close,
Sandbach,
Cheshire CW11 9RQ
England.

Phone: (+44) (0)1270 759739
Fax: (+44) (0)1270 765272
CIS E-Mail: 74774,1347
Internet: 74774.1347@compuserve.com



Order Form - SmartChecker R1

Call +44 (0)1270 759739
Fax +44 (0)1270 765272
CIS: 74774,1347

You can print this order form by using the "Print Topic" option from the "File" menu.

You will receive:-

· A licensed copy of the latest version of Release 1 of SmartChecker, without the reminder 
screens. Whilst we always try to ship as quickly as we can, by Air Mail if outside the UK, please 
allow 21 days for delivery.

· Shareware versions of some of our other software, including SmartCat Plus - the premier 
Windows File Cataloger, Smart Address - a very sophisticated Address Management package 
which is the ideal accompaniment to Smart 'n Sticky, SmartSum - a sophisticated Windows 
emulation of a Printing Calculator which can actually speak the numbers as you say them, plus 
whatever else we have that will fit on the disk.

We can accept your order by mail, E-mail, Fax or Phone. You can also register single copies via the 
Compuserve SWREG service (GO SWREG). Unless otherwise requested we ship a 3.5" disk.

We also offer considerable discounts for multi-copy licences for use across networks, across sites or across corporations. 
Please contact us for details on +44 (0)1270 759739.

Send your order to:-
Oakley Data Services,
3 Oakley Close,
Sandbach,
Cheshire CW11 9RQ,
England.

Please send me __ registered copy(s) of SmartChecker.

Price :- £14.69 Pounds Sterling.
(In the EEC this is made up of 12.50 Pounds, plus VAT @17.5%, no charge for shipping. In the rest 
of the world this is made up of 12.50 Pounds, plus 2.19 Pounds Air-Mail Shipping + Handling).

(As of January 1995 the exchange rate was approximately 1.55 U.S. Dollars to 1.0 Pound Sterling. When we charge your 
credit card the card company will convert the cost to your local currency at the rate then prevailing and the sum will appear on 
your bill in your local currency.)

Total Price : .......................
I enclose a cheque / wish to pay by MasterCard / Visa / Amex (delete as applicable)

(Note: We can only accept cheques payable in the UK drawn in Sterling.)
Credit Card Details:-
Name as on card:-
Card Number:- 



Expiry Date:-

Please send the registered version to:-
Name:
Address:

Post/Zip Code:                                                Day Time Tel. No.

You can also contact us by:-
Phone:+44 (0)1270 759739; FAX: +44 (0)1270 765272; Compuserve: 74774,1347
Internet: 74774.1347@compuserve.com , or via the World-Wide-Web at http://www.smartcode.com ,
or via Section 4 of the UKSHARE forum on Compuserve.

It would also help us if you could tell us where you got SmartChecker from:-

And any suggestions you have for enhancements:-



Order Form - SmartChecker R1

Call 801 295-1890 
Fax 801 299-1781

You can print this order form by using the "Print Topic" option from the "File" menu.

We can accept your order by mail, E-mail, Fax or Phone.    Unless otherwise requested we ship a 
3.5" disk containing a licensed copy of the latest version of SmartChecker R1.

We also offer considerable discounts for multi-copy licences for use across networks, across sites or across corporations. 
Please contact us for details at 801 295 1890.

Send your order to:-
Insight Software Solutions
P.O. Box 354,
Bountiful, UT 84011-0354

Or Call 801 295-1890 
Or Fax 801 299-1781
Or CompuServe:    71672,3464

Please send me __ licensed copy(s) of SmartChecker R1.
Price Per Copy:-

Price                          $19.95 
Utah Residents add Sales Tax   $ 1.22 
Shipping by Fist Class Mail    $ 3.00
       --- or ---
Priority or Int'l shipping     $ 5.00
-----                          ------
Total                          $       
-----                          ------

All Prices are in US Dollars.

I enclose a check / wish to pay by MasterCard / Visa / Amex/ Discover (delete as applicable)

Credit Card Details:-
Name as on card:-

Card Number:- 

Expiry Date:-

Please send the registered version to:-
Name:



Address:

Telephone Number.

It would also help us if you could tell us where you got SmartChecker from:-

And any suggestions you have for enhancements:-






